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I. GEOGEBRA 

 

TUJUAN  

Mahasiswa diharapkan mampu : 

1. Melakukan instalasi Geogebra 

2. Mengeksplorasi dan menggunakan menu dan tool Geogebra untuk 

mengkontruksi objek matematika 

3. Mendesain aktifitas untuk pengintegrasian Geogebra di pembelajaran 

matematika 

 

PENDAHULUAN 

Geogebra dikembangkan oleh Markus Hohenwarter di Universitas Florida Atlantic 

sebagai software pembelajaran matematika dinamis dan tidak berbayar. Geogebra 

memiliki fitur-fitur yang mendukung pembejaran geometri, kalkulus, dan aljabar. 

Selain sebagai media pembelajaran matematika, Geogebra dapat membantu dalam 

penulisan bahan ajar dan juga dapat digunakan untuk menyelesaikan soal 

matematika. 

 

Kegiatan 1: Cara memulai Geogebra 

Klik Start → Program → Geogebra 

atau double Klik lewat ikon geogebra pada Dekstop  

 

Kegiatan 2 : Ikon-ikon pada Geogebra 

 

 

 

 

 

 

 

 

 

 

 

Keterangan 

Input field  

untuk memasukan persamaan grafik fungsi, koordinat titik atau perintah-perintah 

pada comand  

Input Field 

Algebra 
Window 

Toolbar 

Geometry Window 

 



Geogebra 

2 

 

Geometry window 

Jendela pada geogebra untuk menampilkan gambar (grafik, titik, garis, dll) 

Algebra window 

Letak disebalah kiri jendela Geogebra. Setiap objek pada jendela geometri 

dipresentasikan secara aljabar di Algebra window 

Toolbar 

Terdiri atas sebaris tombol  

 

Kegiatan 3: Pengaturan font, labelling dan grid 

Font size: Klik options → font size → pilih misal “12pt” 

Labelling: Klik options → labelling → New point only 

atau klik kanan pada objek → show label 

jika ingin mengubah nama label: klik kanan objek → rename 

jika ingin menampilkan grid: Klik View → Grid 

 

Kegiatan 4a: Titik dan garis 

Titik: Klik file   New   point button              posisikan pada titik yang diinginkan, klik 

kiri. 

Silakan coba: klik arrow  button   geserlah titik semula ke arah manapun, apa yang 

terjadi? 

Garis:  1. klik line button   klik dua titik pada layar yang  akan dilalui garis. 

            2. Gunakan arrow button untuk menggeser garis atau titik. 

Untuk menampilkan koordinat titik: klik kanan titik   properties   show label: value 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4a 

Titik dan garis 
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Gambar 4a 

 Tampilan edit titik dan garis 

 

Kegiatan 4b. Garis sejajar  

1. Buatlah garis yang melalui dua titik 

2. Tentukan satu titik yang akan dilalui garis sejajar 

3. Klik titik dan garis pertama 

4. Jika ingin menghapus titik gunakan: klik kanan titik   show label off. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4bTampilan garis sejajar 

 

Kegiatan 5: Fungsi dan grafik fungsi 

Klik file New masukan rumus fungsi yang akan digambar ke input field, misal 

f(x)=e^x 

Untuk menggeser layar ke kanan, kiri, atas atau bawah gunakan moving drawing pad 

button. 
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Gunakan arrow button untuk menggeser grafik.  Amati perubahan persamaan 

fungsinya. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 5. Tampilan fungsi dan grafik fungsi 

 

Kegiatan 6: Titik belok, Titik stasioner, dan Turunan  

1. Klik file menu New window 

2. Masukkan polinomial f(x) = x^3 – 7x ^2 + 12x – 2 pada input field 

3. Pilih extremum [f] pada menu command (layar bagian pojok kanan bawah) 

4. Pilih inflectionPoint[f] pada menu command 

5. Ketik f’(x) pada input field diperoleh turunan f dan grafiknya 

6. Beri warna biru untuk f(x) dan hitam untuk f’(x) dengan cara klik kanan 

kurva pilih properties / colour , pilih warna. 

7. Simpan file dengan klik save as nama “turunan”. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 6. Tampilan titik belok, Titik stasioner, dan Turunan 
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Kegiatan 7: Garis singgung 

1. Gunakan file “turunan” pada aktivitas 6 

2. Gunakan menu options/point capturing/on 

3. Gunakan point button untuk membuat titik pada kurva  yang akan dilalui 

garis singgung. 

4. Klik menu perpendiculer line button   Pilih tangent button 

5. Klik sekali pada titik dan fungsi 

6. Simpan dengan : save as   nama file “turunan-singgung” 

 

 

 

 

 

 

 

 

 

 

Gambar 7. Tampilan garis singgung 

Kegiatan 8: Integral Rieman 

1. Klik File menu   New window 

2. Klik input field, masukkan f(x) = x^2 lalu tekan enter 

3. Pada input field, ketik juga Integral [f,0,2] untuk menampilkan luas daerah yang 

diarsir. 

4. Klik Move drawing pad button (tombol ke 10 dari kiri) untuk mengatur posisi 

gambar. 

5. Klik Slider button (tombol ke 9), klik satu kali pada layar untuk mengatur nilai 

minimal dan maksimal serta skala. Klik apply. 

6. Ketik UpperSum [f,0,3,n] dan tekan enter. 

7. Gunakan arrow button untuk membuat poligon pada daerah yang diarsir. 

8. Simpan dengan klik Save as. 

 

 

 

 

 

 

 

 

 

 

Gambar 8a. Tampilan Integral Rieman 
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Gambar b. Tampilan Integral Rieman dengan sliders 

 

Kegiatan 9: Sliders dan Fungsi Kuadratik 

1. Klik file menu   new window 

2. Pada input field ketik a=2 lalu enter, ketik b=2 lalu enter dan ketik c=2 lalu 

enter. 

3. Pada algebra window klik kanan a   show object   show label. Lakukan 

kembali untuk b dan c. 

4. Ketik f(x)=a*x^2+b*x+c pada input field. 

5. Gunakan arrow button untuk mengganti- ganti nilai a, b, dan c. 

6. Untuk mengatur warna grafik, klik kanan pilih properties. 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 9. Tampilan grafik fungsi kuadrat dengan sliders 

Kegiatan 10: sudut dan segitiga 

1. Klik line button dan pilih segment button. 

2. Bentuklah segitiga pada geometry window dengan klik titik dan 

menghubungkannya. 

3. Klik angle button   klik titik C,B,A (searah jarum jam) sehingga muncul  

besar sudut ABC. 
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4. Lakukan kembali pada titik sudut yang lain. 

5. Simpan file dengan nama “sudut-segitiga” 

 

 

 

 

 

 

 

 

 

 

 

Gambar 10. Tampilan sudut dan segitiga 

Kegiatan 11: Teks 

untuk menyisipkan teks pada layar gunakan slider button   pilih insert text button. 

Ketik teks yang dikehendaki. Gunakan arrow button untuk mengatur posisi teks. 

 

 

 

 

 

 

 

 

 

 

Gambar 11. Tampilan menyisipkan teks pada layar 

Kegiatan 12: Menghitung dengan Input field 

1. Pilih abjad yunani α,β,γ pada sebelah kanan input field 

2. Ketik pada input field  α + β  + γ 

3. Pada algebra window muncul hasil  α + β  + γ , yakni   = 1800. 

 

Kegiatan 13: Teks Dinamis 

1. Membuat teks dinamis untuk   α + β  + γ = δ. 

2. Klik Insert text button dan ketikkan   α + β  + γ = δ. 

3. Pada kotak dialog, select   lalu klik   pada algebra window 

4. Lakukan kembali untuk   β,  γ, dan δ. 
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5. Untuk menampilkan nama dan panjang sisi: klik kanan objek   properties   

name & value 

6. Jika ingin menhhilangkan sumbu koordinat: klik view   klik axes off. 

 

 

 

 

 

 

 

 

 

 

 

Gambar 13. Tampilan segitiga dengan teks dinamis 

Kegiatan 14: Poligon 

1. Klik file menu new window 

2. Klik polygon button pada toolbar 

3. Klik empat titik berlawanan arah jarum jam untuk menempatkan kelima titik 

sudut sampai klik kembali titik yang pertama. 

4. Pada algebra window muncul koordinat titik, panjang sisi dan luas poligon 

dengan simbol poly1. 

5. Ubah label poly1 dengan area 

6. Untuk menampilkan sudut dalam poligon, klik angle button, klik satu kali 

pada daerah dalam poligon. 

7. Untuk menampilkan panjang sisi, klik angle button   pilih distance button, 

lalu klik pada setiap sisi poligon. 

8. Save as “poligon”. 

 

 

 

 

 

 

 

 

 

 

Gambar 14. Tampilan Poligon 
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Kegiatan 15: Luas dan Keliling Lingkaran 

1. Klik file menu New window 

2. Klik  circle  button   klik satu  titik sebagai pusat lingkaran   klik titik kedua 

yang akan dilalui lingkaran 

3. Persamaan lingkaran akan muncul pada algebra window 

4. Klik  arrow  button   drag  titik  untuk  melihat perubahan persamaan 

lingkaran atau  drag lingkaran dan geserlah u ntuk melihat perubahan 

persamaan lingkaran. 

5. Klik  angle  button    pilih  distance  button    Klik  lingkaran  untuk  

mendapatkan keliling lingkaran 

6. Klik kembali angle button   pilih area button   klik pada lingkaran 

7. Kembali pada distance button   klik dua titik untuk mendapatkan jari-jari 

lingkaran 

8. Hubungkan kedua titik dengan segment button 

9. Save as “lingkaran” 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 15. Tampilan Luas dan Keliling Lingkaran 

 

Kegiatan 16: Translasi, Rotasi dan Refleksi 

1. Bentuklah segitiga pada geometri window dengan klik poligon button 

2. Klik line button   pilih vector button untuk membuat vektor translasi 

3. Klik translation button  klik objek dan vektor 

4. Untuk refleksi: klik objek dan klik garis sumbu refleksi 

5. Untuk rotasi: klik objek dan titik sebagai pusat rotasi   ketik sudut rotasi. 

6. Save as “transformasi” 
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Gambar 16. Tampilan Translasi, Refleksi, dan Rotasi 

 

Kegiatan 17: Perpotongan grafik 

1. Klik file   New window 

2. Ketik pada input field : f(x) = x^2 lalu enter. Ketik juga g(x)=x+2 

3. Klik point button   pilih intersect two objects button 

4. Klik sekali pada titik potong grafik 

5. Save as “titik potong” 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 17. Tampilan titik potong grafik 

Kegiatan 18: mengatur sumbu koordinat 

1. Klik kanan layar geometry window   pilih graphics view 

2. Aturlah nilai pada sumbu x minimal dan maksimal -4 dan 4 

3. Aturlah nilai pada sumbu y minimal dan maksimal -1 dan 6 

4. Untuk mengatur skala : klik kanan   graphics view 
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II.   GRAPH 

 

A. Apa Itu GRAPH ? 

GRAPH adalah softwar  yang dirancang untuk menggambar/melukiskan  

grafik fungsi matematika ke dalam sistem koordinat dan sejenisnya. Program ini 

merupakan program Windows standar dengan menu dan dialog. Program ini 

mampu menggambarkan standard functions, parametric functions, polar 

functions, tangents, point series, shadings dan relations. Hal ini juga 

memungkinkan untuk mengevaluasi fungsi untuk suatu titik tertentu, melacak 

grafik dengan mouse dan banyak lagi. Program ini akan memudahkan para 

pencinta matematika dalam memahami sebuah fungsi di dalam bentuk gambar. 

B. Daftar item menu   

Berikut ini adalah daftar semua item menu dalam program:  

1.  (Ctrl + N) 

Digunakan untuk membuat sistem koordinat baru guna menggambar grafik 

2.  (Ctrl + O) 

Membaca file sistem koordinat yang disimpan sebelumnya. 

3.  (Ctrl + S) 

Menyimpan sistem koordinat ke file. 

4.  

Menyimpan sistem koordinat ke file dengan nama baru. 

5. (Ctrl + B) 

 Menyimpan sistem koordinat yang sedang tampil, sebagai gambar. 

Ketika item menu telah dipilih, dialog Save As standar akan muncul.  

 Mengimpor isi file GRAPH lain ke dalam sistem koordinat saat ini. 

6. . 

Mengimpor satu atau beberapa titik seri dari tab, koma atau titik koma 

memisahkan file data. Kolom pertama harus memuat koordinat-x. Kolom 

berikut memuat koordinat-y. Grafik akan menciptakan banyak titik seri 

karena ada kolom dengan koordinat-y dalam file. Tidak ada batasan untuk 

jumlah seri titik mungkin terjadi dalam data file selama mereka membagi 

sama koordinat-x. 

7. .     (Ctrl + P) 

Mengirimkan sistem koordinat dan grafik ke printer untuk dicetak. 

8. .     (Alt + F4) 

Keluar dari program. Anda mungkin akan diminta untuk menyimpan file. 

File 

File New 

Open 

File Save 

File Save as 

File Save as 

image… 

File Import Point 

series… 

File Print… 

File Exit 
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9.      (Ctrl + Z) 

Digunakan untuk membatalkan perintah terakhir yang dilakukan. Anda dapat 

memilih berapa jumlah pembatalan langkah-langkah yang disimpan dalam 

dialog Options. 

10. .     (Ctrl + Y) 

Digunakan untuk mengulang hal dibatalkan terakhir. Ini hanya tersedia setelah 

memilih  

11. .     (Ctrl + X) 

Digunakan untuk menyalin elemen GRAPH yang dipilih ke clipboard. Elemen 

tersebut akan dihapus setelah itu. 

12. ..     (Ctrl + C) 

Digunakan untuk menyalin elemen Graph yang dipilih ke clipboard. 

13. .     (Ctrl + V) 

Dugunakan untuk menyisipkan elemen graph sebelumnya yang disalin dari 

clipboard ke dalam sistem koordinat. 

14. .     (Ctrl + I) 

Digunakan untuk menampilkan sistem koordinat ke clipboard sebagai gambar. Anda 

kemudian dapat menempelkannya ke program lain, yaitu Microsoft Word. 

15. .     (Ctrl + A) 

Digunakan untuk mengedit spesifikasi untuk sumbu, misalnya skala, warna, 

penempatan legenda, dll. 

16. . 

Ini akan mengubah pengaturan global Graph, mis asosiasi file .grf, menunjukkan 

tentang tooltips, jumlah maksimum undo yang disimpan, dll 

17. ..       (Ins) 

Menyisipkan fungsi ke dalam sistem koordinat. Fungsi dapat ditambahkan dengan 

lebar dan warna yang berbeda, memilih untuk hanya menampilkan grafik pada 

interval tertentu, dan menentukan pengaturan lainnya juga. 

18.  .       (F2) 

Gunakan dialog ini untuk menambah garis singgung ke fungsi yang sudah 

ditunjukkan pada titik yang ditentukan pengguna. Tangen akan ditambahkan 

ke fungsi yang dipilih dalam daftar fungsi. 

19. .        (F3)  

Item menu ini digunakan untuk menambah arsir untuk fungsi yang dipilih. Anda 

dapat memilih antara berbagai macam gaya bayangan dan warna yang berbeda. 

Shading dapat ditambahkan di atas fungsi, di bawah fungsi, antara fungsi dan 

sumbu x, antara fungsi dan sumbu y, di dalam fungsi atau antara dua fungsi. 

Function Insert tangent... 

Function Insert shading... 

Function Insert function... 

Edit Options

… 

Edit Redo 

Edit Undo 

Edit Cut 

Edit Paste 

Edit Undo 

Edit Copy 

Image 

Edit Copy 

Edit Axes… 

mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertShadingDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
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20.        (F7)  

Dialog ini digunakan untuk menambah turunan pertama fungsi yang dipilih. 

21.          (F4)  

Berfungsi untuk menyisipkan titik seri baru ke dalam sistem koordinat. 

Jumlah titik yang tak terbatas ditentukan oleh koordinat x dan y yang 

mungkin akan ditambahkan. Ini memungkinkan untuk memilih warna, 

ukuran, dan gaya dari seri titik. 

22. ..        (Ctrl +  T)  

Menyisipkan trendline sebagai kurva paling cocok untuk titik seri yang 

dipilih. Anda dapat memilih jenis fungsi untuk trendline. 

23. .       (F6) 

Berfungsi untuk menyisipkan persamaan atau pertidaksamaan dalam sistem 

koordinat. Persamaan dan pertidaksamaan digunakan untuk menyatakan 

hubungan antara koordinat x dan y dengan operator yang sama dll seperti 

untuk grafik fungsi. Relasi mungkin akan ditambahkan dengan gaya arsir dan 

warna yang berbeda. 

24. .       (F8) 

Ini akan menunjukkan dialog, yang dapat digunakan untuk membuat label 

teks berformat. Label akan selalu dibuat di tengah area grafik tetapi dapat 

kemudian diseret ke tempat lain dengan mouse.   

25. .      (Enter) 

Ini akan menunjukkan sebuah dialog di mana Anda dapat mengubah elemen 

grafik yang dipilih dalam daftar fungsi. 

26. .       (Del) 

Ini akan menghapus elemen grafik yang dipilih dalam daftar fungsi. 

27. .       (Ctrl + F ) 

Ini menampilkan dialog yang digunakan untuk membuat fungsi kustom dan 

konstanta selain yang terintegrasi. 

28. .        (Ctrl + +) 

Ini akan memperbesar bagian tengah area grafik, sehingga akan melihat ¼ 

dari area grafik sebelumnya. 

29. .      (Ctrl + -) 

Ini akan memperkecil sehingga Anda melihat 4 kali sebesar pada daerah 

grafik sebelumnya. 

30. .       (Ctrl + W) 

Tahan tombol kiri mouse saat Anda memilih area yang meliputi area grafik 

secara keseluruhan. Klik kanan atau tekan Esc untuk membatalkan perintah. 

Function Insert label... 

Function Edit... 

Function Delete 

Function Custom functions... 

Zoom In 

Zoom Out 

Zoom Window 

Function Insert f'(x)... 

Function Insert 

trendline... 

Function Insert point series... 

Function Insert relation... 

mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertDerivativeDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertPointSeriesDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertTrendlineDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertLabelDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/CustomFunctionsDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
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31. .       (Ctrl + Q) 

Ini akan mengubah sumbu y dengan skala yang sama dengan sumbu x. Hal 

itu akan membuat lingkaran tampak benar-benar bulat, tidak elips. Sumbu 

akan tetap berskala sama sampai dinonaktifkan lagi. 

32. .       (Ctrl + D) 

Mengembalikan pengaturan sumbu ke pengaturan standarnya, kembali sama 

seperti saat pertama membuat sistem koordinat baru. 

33. .         (Ctrl + M) 

Ketika memilih perubahan pointer mouse ke tangan. Sekarang Anda dapat 

menggunakan mouse untuk menyeret sistem koordinat sekitar. Pilih item 

menu lagi, klik kanan atau tekan Esc untuk kembali ke mode normal. Sebagai 

alternatif untuk item menu ini, Anda dapat tahan tombol Shift dan tarik 

sistem koordinat sekitar. 

34. .       

Ini akan mengubah pengaturan sumbu untuk menampilkan semua bagian dari 

elemen grafik yang dipilih. 

35. . 

Ini akan mengubah pengaturan sumbu untuk menampilkan semua bagian dari 

semua elemen dalam daftar fungsi. 

36. . 

Menghitung jarak sepanjang jalur antara dua titik pada grafik yang dipilih. 

37. . 

Menghitung integral tertentu untuk berbagai domain tertentu. Ini sama 

dengan daerah yang ditandatangani antara grafik dan sumbu x. 

38. .       (Ctrl + E) 

Ini akan mengevaluasi fungsi yang dipilih untuk nilai yang diberikan. Untuk 

fungsi standar f (x), f '(x) dan f' '(x) dievaluasi. Untuk fungsi parametrik x (t), 

y (t), dx / dt, dy / dt dan dy / dx dievaluasi. Untuk fungsi polar r (t), x (t), y 

(t), dr / dt dan dy / dt dievaluasi. 

39. . 

Dialog ini mengisi tabel dengan berbagai-pengguna tertentu nilai-nilai dan 

hasil evaluasi fungsi yang dipilih untuk nilai-nilai.  

40. . 

Dialog ini memungkinkan Anda untuk membuat animasi dari data dalam 

sistem koordinat dengan mengubah kustom konstan yang ada. Hal ini 

memudahkan untuk melihat apa yang terjadi ketika konstan berubah. Animasi 

dapat disimpan ke file disk. 

Zoom Fit All 

Zoom Fit 

Zoom Move system 

Zoom Length of path  

Zoom Table...  

Zoom Evaluate 

Zoom Integrate  

Zoom Animate...  

Zoom Square 

Zoom Standard 

mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertRelationDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/EvaluateDialog.html#LengthOfPathFrame
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/TableDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/EvaluateDialog.html#AreaFrame
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/AnimateDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
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41. . 

Ini adalah tempat umum untuk plugin untuk menempatkan item menu yang 

mengaktifkan plugin. Menu tidak akan ditampilkan jika tidak ada plugin atau 

sistem plugin tidak tersedia. 

42. .        (F1) 

Menunjukkan isi dan indeks file bantuan. 

43. .       (Alt + F1) 

Menampilkan daftar fungsi dan konstanta yang dapat digunakan untuk 

merencanakan grafik. 

44. . 

Ini akan menampilkan daftar pertanyaan yang sering diajukan dan jawaban 

mereka. 

45. . 

Ini akan menunjukkan beberapa tips tentang cara menggunakan Graph 

dengan cara yang lebih optimal, dan fitur tertentu dari Grafik Anda mungkin 

tidak tahu tentang. 

46. . 

Menunjukkan situs web untuk Grafik di web browser default Anda. 

47. . 

Menunjukkan forum dukungan untuk Graph di web browser default Anda. 

48. . 

Shows the web page that allows you to donate to the Graph project to support 

its development.  

49. . 

Ini akan memeriksa apakah versi baru Graph tersedia. Jika ada versi baru, 

Anda akan ditanya apakah Anda ingin mengunjungi situs web dari Graph 

untuk men-download versi baru. 

50. .       (Alt + F1) 

Menunjukkan nomor versi, hak cipta dan lisensi informasi untuk Graph. 

 

 

 

 

 

 

 

 

Plugins 

 

Help Contents and index 

Help List of functions 

Help Internet 

Help Tip of the day 

Help Frequently Asked 

Questions 

Graph web 

site 

Help 

Help Internet Donate 

Internet Support 

Help 

Help Internet Check for update 

About Graph 

mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
mk:@MSITStore:C:/Program%20Files%20(x86)/Graph/Help/Graph-English.chm::/InsertFunctionDialog.html
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C. Contoh Pengoperasian GRAPH 

Buka Program Graph 

 

 

 

 

 

 

 

 

 

 

Pilih function lalu insert function 

 

 

 

 

 

 

 

 

 

 

 

Masukkan di function equation: 

Contoh : x^2+x-6 
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Lalu pilih ok akan muncul seperti ini: 

 

 

 

 

 

 

 

 

 

Buatlah fungsi baru dengan merubah warna garis dari garis tersebut dengan cara 

memilih color. Contoh: 2x^2+4×-16  

Lalu akan muncul grafik seperti ini 

  

 

 

 

 

 

 

 

 

 

 

 

Hapus kan tanda centang pada fungsi yang pertama (di sebelah kiri dari layar) 

maka akan tampil seperti ini (yang terlihat hanya gambar fungsi yang terakhir) 
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MEMBUAT PERSAMAAN LINIER 

Cara membuat persamaan linear dengan grafik. Pilih (Klik) Function lalu pilih Insert 

Relation. 

 

 

 

 

 

 

 

 

 

 

Ketikkan Pertidak samaan linier 2×-12>=0 

 

 

 

 

 

 

 

 

 

 

Lakukan dengan cara yang sama, untuk pertidak  samaan kedua 2x-y>=1. Maka 

tampilannya akan seperti di bawah ini. 
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Menggambar dua fungsi yang dibatasi oleh X positif dan Y positif. Pilih (klik) 

Function lalu insert relation seperti cara diatas. Ketikkan 2 fungsi diatas dengan 

penulisan : 2x>=12 and 2x-y>=1  kemudian pada Tab Constrain ketikkan :  x>=0 dan 

y>=0 

 

 

 

 

 

 

 

 

Maka tampilannya akan seperti di bawah ini 

 

 

 

 

 

 

 

 

 

Dengan cara yang sama kita juga dapat membuat fungsi exponensial berikut : 

f(x)=(e^(5x))-5^x 
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CARA MEMBUAT TITIK KOORDINAT PADA KOORDINAT X DAN Y 

Pilih (Klik) Function  –> Point Series 

 

 

 

 

 

 

 

 

 

 

 

Masukkan koordinat X dan Koordinat Y yang diinginkan 

 

 

 

 

 

 

 

 

 

 

Hasilnya akan seperti berikut ini 
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Pilih (Klik) Insert Function–> Ganti function type (Standard Function) dengan Polar 

Function 

 

 

 

 

 

 

 

 

 

Tuliskan fungsi    4 + 4 cos (t)  pada function equation, maka tampilannya akan 

seperti dibawah ini 

 

 

 

 

 

 

 

 

 

Hilangkan tanda centang pada funsi pertama, kemudian buatlah fungsi kedua 4 + 4 

sin(t)  dengan cara yang sama. Maka tampilannya akan seperti berikut. 
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MENGARSIR DAERAH DIANTARA DUA KURVA 

Centang kembali dua fungsi terakhir sehingga fungsi tersebut akan tampil di layar 

 

 

 

 

 

 

 

 

 

 

Pilih Function –> Insert Shading(pilih (tandai/cheklist) Between Function –>klik tab 

2nd function –> pilih fungsi 4+4 cos (t) 

 

 

 

 

 

 

 

 

 

 

maka tampilannya akan seperti ini 
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III.   MAPLE  

 

1. PENGANTAR MAPLE  

a. Pengertian Maple 

Maple adalah salah satu paket program atau program aplikasi matematika yang 

berbasis computer. Maple mampu melakukan perhitungan-perhitungan dengan cepat, 

mampu menyelesaikan persamaan-persamaan dalam matematika, serta mampu 

menggambarkan grafik fungsi matematika, simulasi modeling bahkan dapat 

menampilkan gambar dalam bentuk animasi. 

Program maple mampu menjadi solusi dalam berbagai topik matematika, seperti 

analisis numerik, aljabar simbolik, kalkulus, persamaan diferensial, aljabar linear, 

simulasi dan visualisasi. 

Sesungguhnya, Maple tidak hanya berguna untuk melakukan perhitungan 

matematis saja, namun juga dapat digunakan sebagai editor teks yang menghasilkan 

dokumen dengan memuat penjelasan atau uraian verbal dan berbagai perhitungan 

matematis. 

Dengan kemampuan visualisasi matematis interaktif, sebuah antarmuka grafis 

tempat menuliskan masukan dan menampilkan keluaran yang menyerupai notasi 

matematika yang sesungguhnya, fasilitas pengolahan kata, dan bahasa pemrograman, 

Maple telah digunakan oleh jutaan pemakai di seluruh dunia di kalangan pendidikan, 

lembaga riset, dan industri. 

 

b. Memulai menggunakan aplikasi Maple 

Saat kita akan menggunakan alpikasi Maple kita harus tahu jenis mesin yang 

kita gunakan. Jika kita sedang menggunakan Window, klik 2 kali pada icon Maple 

yang akan langsung memberikan respon dengan menampilkan jendela Maple seperti 

di bawah ini. 
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tampilan awal Maple 

 

Pilih              untuk membuka lembar kerja Maple.  

Pada layar Maple secara otomatis muncul simbol prompt > “[ >” . Simbol  ini 

otomatis dan sebagai tanda bahwa Maple telah siap dioperasikan dengan cara 

menuliskan perintah-perintah di depan symbol tersebut. 

Jangan lupa mengakhiri perintah dengan semicolon (;), bila akan segera ingin 

mengetahui hasil operasi Maple. Perintah diakhiri dengan colon (:) bila hasilnya 

tidak ingin ditampilkan tapi tetap diproses. Selanjutnya tekan [Enter], sebaiknya 

sebelum perintah-perintah diberikan pada Maple, dimulai dulu dengan perintah  

[ >  restart ;   untuk pengosongan memori. 

 

2. PENGOPERASIAN MATEMATIKA DALAM APLIKASI MAPLE 

a. Operasi Aritmetika  

Operasi dasar pada Maple adalah sebagai berikut: 

Simbol Fungsi 

+ dan - Tambah dan kurang 

* dan / Kali dan bagi 

^ Pangkat 

Sqrt Menghitung akar 

Sum(f(x),x=i) 

 Sum(f(x),x=i,,,infinity) 

jumlah deret berhingga suku 

jumlah deret takberhingga 

suku 

Product(f(x)) Hasil kali berhingga faktor 
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Contoh 1 :  

Pastikan kamu berada di Model Math (Math Mode), dan ikuti langkah-langkah 

di bawah ini untuk memasukkan operasi . 

Langkah Deskripsi Ilustrasi 

1 

 

Tekan , kemudian . Math mode 

maple menyajikan beragam pilihan 

dari konstanta dan variabelnya sebagai 

multiaplikasi implisit. 

 

 

2 

 
Tekan tanda bagi [/].  

 

3 

 
Tekan 5.  

 

4 

 

Untuk membawa kursor kembali ke 

dalam baris, tekan  tanda anak panah 

ke kanan [→]di keyboard. 

 

 

5 

 

Tekan [+]. Disini tidak membutuhkan 

spasi, secara otomatis Maple 

menyesuaikan spasi untuk kita. 

 

 

6 

 

Ulangi langkah 1 sampai dengan 4 

untuk . 
 

 

7 

 

 Jika kamu ingin melanjutkan  typing 

non-mathematical text, tekan [F5] 

untuk mengalihkan ke Text mode. 
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Contoh 2:  

Pastikan kamu berada di Model Math (Math Mode), dan ikuti langkah-

langkah di bawah ini untuk memasukkan operasi . 

 

b. Fungsi dalam Maple 

Nama Maple Fungsi 

e^x Fungsi exponent   (  ex ) 

ln(e) Logaritma Natural   =  log[e] 

sin(x), cos(x), tan(x), cot(x), sec(x), 

csc(x) 
Fungsi trigonometri 

arcsin(x), arcos(x) dan lainnya Invers trigonometri 

sinh(x), cosh(x) dan lainnya Hiperbolik 

arcsinh(x), arccosh(x) dan lainnya Invers hiperbolik 

abs(x) Nilai mutlak 

ifactor(x) Faktorisasi prima 

seq(..) Barisan bilangan 

Length Menghitung digit dalam sebuah desimal 

Langkah Deskripsi Ilustrasi 

1 
Klik  dalam kolom Expression palette. 

Tempat yang bertuliskan hijau     telah terpilih 

secara otomatis. 

 

2 Tekan    mengganti huruf   .      
 

3 

 

Untuk memasukkan fungsi eksponen, yang 

biasa di gunakan dalam Maple adalah karakter 

[^] yang dihasilkan oleh kombinasi [Shift][6]. 

Kursor sekarang dalam fungsi eksponen. 

Kemudian tekan . 

 
 

4 

 

Untuk membawa kursor kembali ke dalam 

baris, tekan  tanda anak panah ke kanan [→] di 

keyboard. 
 

 

5 

 

Tekan [+].  Disini tidak membutuhkan spasi, 

secara otomatis Maple menyesuaikan spasi 

untuk kita. 
 

 

6 

 

Tuliskan  pi, dan tekan [Esc]. Akan tampil 

command completion list, disini tersedia daftar 

setiap simbol dan perintah sesuai nama yang di 

awali dengan pi. Untuk bentuk Yunani pi, pilih 

. 

 

7 

 

Jika kamu ingin melanjutkan  typing non-

mathematical text, tekan [F5]  

untuk mengalihkan ke Text mode. 
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Dalam Maple semua satuan sudut yang digunakan adalah radian.  

Maple juga menyediakan konstanta-konstanta penting dalam matematika. Untuk 

menggunakan nilai  ketik Pi. Maple menggunakan nilai eksak untuk , bukan 

hampiran numeriknya. Namun Jika kita menulis nama fungsi yang tidak dikenal oleh 

Maple, maka akan muncul pesan error: 

Contoh 3:  

> 4*(3+Pi);    

 

>sin(5*Pi/3);    

 

 >sec(Pi/4);       

 

>arcsin(-1);    

  

c. Manipulasi Polinomial  

Perintah Maple Tujuannya 

Simplify Menyederhanakan expresi aljabar 

Expand Menguraikan suatu expresi 

Factor Memfaktorkan suatu expresi 

Solve Menyelesaikan system persamaan 

Fsolve Memberikan solusi numerik 

Evalf 
mencari hasil akhir yang lebih 

spesifik bentuk desimal 

 

Contoh 4  

Selesaikan persamaan  untuk  menggunakan menu solve>Solve for 

Variable>x dari konteks menu. 

> solve( { a*x^2+b*x+c = o }, [x] ); 

 

 

 

d. Substitusi  

Untuk dapat melakukan operasi substitusi terlebih dahulu kita mendefinisikan suatu 

ekspresi. Setelah itu kita baru mensubtitusikan variable dengan nilai tertentu yang kita 

inginkan.  

Contoh 5 

ekspresi:=sin(x)^2+sin(x);  

subs(x=eta,ekspresi);  
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hasil:=evalf(subs(x=Pi/3,ekspresi)); 

 

 

 

 

 

 

e. Menghitung Nilai Limit  

Maple juga dapat digunakan untuk mencari penyelesaian dari persoalan yang ada 

pada kalkulus, salah satunya yaitu mencari atau menghitung nilai limit.  

Contoh 6 

Diff(h(x),x)=diff(h(x),x);  

B:=Diff(h(x),x)=simplify(diff(h(x),x));  

subs(x=10,rhs(B)) 

 

 

 

 

 

 

Keterangan rhs(B) adalah right hand side dari B  

Diff(h(x),x$2)=simplify(diff(h(x),x$2)). 

 

f. Menyelesaikan Persoalan Integrasi  

Dalam Maple untuk menyelesaikan persoalan integrasi menggunakan perintah 

Int(fungsi integrand, variable); . Walaupun sedang menghitung integral taktentu, 

Maple tidak memunculkan konstanta sembarang C.  

Contoh 7 

Int(h(x),x)=int(h(x),x); 

Int(Int(h(x),x),x)=int(int(h(x),x),x);  

Int(h(x),x=0..2)=evelf(int(h(x),x=0..2)); 

 

 

 

 

 

 



Maple 

29 

 

g. Grafik 

Maple mampu menggambar grafik suatu fungsi dimensi satu, dimensi dua atau 

dimensi tiga. Perintahnya [ > plot(…….); . Sebelum perintah plot diberikan panggil 

dulu paket perintah ini [ > with(plots);  

Contoh  

Gambarlah hasil pengintegralan dari  

 

 

 

 

 

 

 

 

  

a. Menggunakan Menu Peka-Konteks 

Dengan menggunakan hasil atau ekspresi Maple yang sudah ada, kita dapat 

melakukan tindakan baru. Untuk melihat daftar tindakan yang dapat kita lakukan 

terhadap sebuah objek Maple, klik kanan objek Maple tersebut. Kita akan melihat 

sebuah menu peka-konteks, karena isinya tergantung objek yang sedang kita tunjuk. 

Sekarang boleh kita coba lakukan. Jalankan Maple, tuliskan perintah berikut ini di 

layar Maple. 

> z=sin(x^2*y);  

1. Arahkan mouse ke baris perintah (yang berwarna merah) kemudian klik 

kanan, menu apa saja yang bisa kita lihat? Pilih salah satu, misalnya menu 

Execute. Kita akan melihat tampilan outputnya dalam bentuk ekspresi 

matematika baku. Kita dapat mencoba menu yang lain jika mau!  

2. Sekarang arahkan mouse ke ekspresi output (yang berwarna biru), kemudian 

klik kanan, menu apa saja yang ditampilkan? Samakah dengan menu 

sebelumnya? Tidak bukan? Pilih salah satu menu, misalnya Plots --> 3D 

Implicit Plot --> x,y,z. Kita akan melihat sebuah baris perintah baru dan 

outputnya berupa gambar yang merupakan permukaan dengan persamaan 

tersebut, seperti di bawah ini. (kita akan mendapatkan hasil dari menu peka-

konteks langsung di bawah objek yang kita tunjuk!)  

> smartplot3d[x,y,z](z=sin(x^2*y)); 
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b. Geret dan Taruh (Dragging and Dropping)  

Kita dapat memindahkan output Maple dari atau ke Maple plot. Jika kita 

memindah hasil sebuah persamaan ke sebuah Maple plot, persamaan tersebut akan 

ditampilkan sebagai plot kurva atau permukaan. Sebaliknya, jika kita memindah 

sebuah kurva atau permukaan dari Maple plot ke tempat lain, maka persamaan kurva 

atau permukaan tersebut akan ditampilkan. Cobalah kita lakukan dengan memindah 

(dengan cara mendrag bukan copy & paste) gambar di atas ke tempat lain. 

Selanjutnya, coba menggunakan perintah di bawah ini, pindahkan outputnya ke 

gambar di atas dan lihat hasilnya. 

> z=sin(x^2)*y^2;  

 

 

> smartplot3d[x,y,z](z = sin(x^2)*y^2); 

 

 

 

 

 

c. Plot Option  

Dalam plot juga ada beberapa pilihan atau option yang harus diperhatikan 

yaitu diantaranya adalah  

1. Color : Pilihan ini berfungsi untuk menentukan warna dari grafik ayang 

akan ditampilkan. Dan dalam pemilihan ini penulisannya berdasarkan ejaan 

bahasa inggris. Misalnya ingin membuat grafik warna merah maka warna 

yang dituliskan adalah “red” jika menginginkan warna biru maka dapat 

menggunakan atau mengetik kata “blue” dan lain-lain.  

2. Style : Style merupakan suatu pilihan untuk menentukan bentuk dari 

gambar atau grafik yang akan kita buat. Dalam style ini ada dua macam 

yaitu “point” atau “line”.  

a. Point adalah grafik yang dibentuk berupa point atau titik-titik yang 

membentuk suatu garis atau kurfa. 

b. Line yaitu garis atau kurfa yang akan dibuat berbentuk garis. 

3. Title : Agar dapat membedakan antara gambar satu dengan gambar yang 

lain maka masing-masing gambar dapat diberi nama sesuai dengan 

keperluanya melewati option labels.  
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4. Linestyle : Linestyle merupakan suatu option yang digunakan untuk 

menentukan daereah mana yang akan digambar atau biasanya disebut 

dengan batasan-batasan suatu daerah. 

5. Labels : Labels berfungsi sebagai nama dari dua hal yang akan 

dihubungkan biasanya untuk menamakan label pada sumbu x dan sumbu y. 

 

3. PENGATURAN DOKUMEN  

Maple bukanlah sekedar alat bantu untuk perhitungan matematika, namun juga 

berguna untuk menghasilkan naskah yang syarat dengan perhitungan-perhitungan 

matematika. Sebuah dokumen Maple, selain memuat ekspresi Maple dan outputnya 

(kelompok eksekusi), juga dapat memuat paragraf dan hyperlink. Berikut dijelaskan 

bagaimana cara pengaturan dokumen di dalam Maple. 

a. Paragraf dan Teks  

Paragraf memuat teks, notasi matematika, grafik, termasuk duplikat output 

Maple, seperti plot. Sebuah paragraf juga dapat ditulis di dalam kelompok 

eksekusi. Paragraf berisi uraian atau penjelasan. Kita dapat mengatur format 

paragraf dan tulisan, seperti halnya di pengolah kata biasanya. Berikut adalah 

contoh-contoh pengaturan paragraf dan teks serta tulisan yang dapat kita lakukan 

di dalam dokumen Maple. 

1. Paragaf terpusat. 

2. Paragraf rata kiri.  

3. Paragraf rata kanan.  

4. Teks dapat dicetak dengan huruf miring, digaris bawahi, cetak tebal, atau 

kombinasi. 

5. Kita  juga dapat mengatur ukuran dan jenis huruf sesuka kita!  

Seperti halnya pada pengolah kata dan dekstop publisher, kita dapat 

membuat format paragraf dan teks kita sendiri, dengan menggunakan menu 

Format --> Styles. 

Kita dapat menuliskan notasi matematika dan menampilkan grafik di dalam 

sebuah paragraf, sehingga kita dapat menulis artikel tentang matematika secara 

lebih komprehensif. Untuk menuliskan notasi matematika di dalam paragraf, 

tekan tombol Ctrl+R, Maple akan berganti ke modus notasi matematika. Untuk 

berganti ke modus teks tekan Ctrl+T. 

b. Alat Pengolah Kata 

Maple mengandung banyak alat pengolah kata untuk membantu kita 

membuat laporan profesional. Untuk referensi, di sini terdapat daftar beberapa  

fitur yang lebih umum. 
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Fitur Letak 

Merancang  judul Drag kebawah dalam deretan 

toolbar 

Bagian dan subbagian  

 

Insert > Section, Insert > 

Subsection 

tabel  Insert > Table 

Kontrol Font dan kemampuan untuk 

menentukan format baru  

Toolbar buttons, Format > Styles... 

Kemampuan untuk menyisipkan foto 

dan objek lainnya  

Insert > Image 

 

memeriksa ejaan dari istilah 

matematika  

Tools > Spellcheck 

 

Hyperlink dan bookmark  Format > Convert To > 

Hyperlink 

Format > Bookmarks... 

Nomor halaman, header, dan footer  View > Header Footer... 

Ekspor ke HTML  File > Export As... 
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Contoh-Contoh Penggunaan Maple dalam Menyelesaikan Masalah Matematika 

1. Aritmatika  

Bentuk Matematika Operasi Maple Hasil Keterangan 

?
7

2

3

1
  

> 1/3 + 2/7; 

21

13
 

Hasilnya pecahan 

biasa 

?
7

2

3

1
  

> evalf(1/3 + 2/7); 0.6190476190 Hasilnya pecahan 

desimal 

?
7

2

3

1
  

> evalf(1/3 – 2/7); 0.04761904762 Hasil 

pengurangan 

pecahan 

?
4

275
  

> evalf(275/4); 68.750000000 

 

Hasil pembagian 

211 x 15 > 211 * 15; 3165 Hasil perkalian 

?75.234   
> sqrt(234.75); 15.32155345 Hasil penarikan 

akar 

125=? > 12^5; 248832 Hasil 

perpangkatan 




1.0
2

)7.13.1(3 2

 

> 3 * (1.3 + 1.7)^2/2; 13.40000000 Menunjukkan 

urutan pengerjaan 

: ( ), pangkat, kali, 

bagi dan kurang 

10

1
...

3

1

2

1
1   

> sum(1/n, n = 1 . . 10); 2.928968254 Hasil 

penjumlahan 

deret. 

Cari factor-faktor dari  

302330880000 

> ifactor(302330880000); (2)13    (3)10     (5)4 Mencari factor-

fatktor prima dari 

suatu bilangan 

yang bukan prima 

5 ! > 5!; 120 Faktorial dari 

bilangan 5 

Bulatkan   7.432 > round(7.432); 7 Membulatkan 

bilangan 

...
4

7
adalahsisanya  

> 7 mod 4 3 Mencari sisa dari 

pembagian 

 = ? > evalf(Pi); 3.141592654 Nilai   (Pi )  P 

harus huruf besar 

e  =  ? > evalf(exp(1)); 2.718281282 Mencari nilai e  ( 

e = exp ). exp(1) = 

e1 = e 
10log(123.75) = ?    atau 

Log(123.75)  = ? 

 

> log[10](123.75); 

 

2.92545208 

Log[10]  

maksudnya  10Log 

Mencari nilai log 

dengan bil.pokok 

10 
2log(123.75) = ? > log[2](123.75); 6.951284715 Mencari log dgn 

bil pokok 2 dari 

123.75 
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2. Aljabar 

Bentuk 

Matematika 

Operasi Maple Hasil Keterangan 

Faktorkan  a2 + 2ab 

+ b2 
> factor(a^2 + 2*a*b + 

b^2); 

( a + b )2 Memfaktorkan 

bentuk aljabar 

 > p := (a+b)^2; p:= (a + b)2 Mendefinisikan p  

 > expand(p); a2 + 2ab + b2 Mencari pangkat dua 

dari p 

 > a:=1; a := 1 Memberi nilai 

kepada a (a = 1). 

 > p; ( 1 + b )2 Merubah nilai  p 

 > a = ‘a’ a := a Nilai a dikembalikan 

ke semula 

 > p; ( a + b )2 Mengecek kembali 

nilai p 

Sederhanakan 

bentuk : 

xx

xxx

)2(

23 23



  

> 

simplify((x^3+3*x^2+2*

x)/((x+2)*x); 

X+1 Menyedarhanakan 

bentuk aljabar 

k := 

4

)2()21(

4

)2(

2

22 xCosxxCosx 


 

> simplify(k); 
1

2
x2 ( ) 1 ( )cos 2 x

 
Menyederhanakan 

:

4

)2()21(

4

)2(

2

22 xCosxxCosx 


 

 > restart;  Mengosongkan 

memori 

Selesaikan x2 – 5 = 0 > fsolve( x^2 – 5 = 0); -2.236067977     

2.236067977 

Menyelsaika 

persamaan 

 > solve(x^2 – 5 = 0, {x}); {x= 5 } ,  

{x = - 5 } 

Perhatikan 

perbedaannya 

Tulis fungsi 

polynomial : 

polynomial := 

24x5+105x4-

10x2+17x-10 

> polynomial := 24*x^5 

+ 105*x^4-

10*x^2+17*x-10; 

polynomial := 

24x5+105x4-

10x2+17x-10 

Mendefinisikan 

fungsi polinomial 

Cari akar-akar 

polynomial di atas 

untuk  -5 < x < 5 

> fsolve(polynom ial , x 

= -5 . . . 5); 

-4.343092665  ,   

-0.7577682339  , 

0.4425545605 

Menyelesaikan 

polynomial 

Selesaikan : 









62

532

yx

yx
 

> Pers_1 := 2*x + 3*y = 

5; 

> Pers_2 :=    x  -  2*y = 

6; 

>fsolve({Pers_1,Pers_2}, 

{x,y}); 

Pers_1 := 2x +3y 

= 5 

Pers_2 :=  x + 2y 

= 6 

{y=-1 , x=4} 

Menyelesaikan 

system persamaan. 

Selesaikan : 















62

43

32

zyx

zyx

zyx

 

> p1:= x+2*y-z=3; 

> p2 := 3*x+y+z=4; 

> p3 := x-y+2*z=6; 

>fsolve({p1,p2,p3}, 

{x,y,z}); 

{ }, ,x -5. z 10. y 9.  

 

Menyelesaikan 3 

persamaan dengan 3 

variabel 

Selesaikan : 

2x2 – 5x + 10 = 0 
> solve(2*x^2 – 5*x +10 

= 0 , {x}); 
,{ }x 

5

4

1

4
I 55 { }x 

5

4

1

4
I 55  

 

Menyelesaikan 

persamaan 
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3. Trigonometri 

Bentuk 

Matematika 

Operasi Maple Hasil Keterangan 

Sin(30) = ? > evalf(sin(30)); - 0.9880316241 Sudut dalam 

radian 

Sin(300) = ? > sin(30*Pi/180); ½ Sudut dalam 

derajat 

 > evalf(sin(30*Pi/180)); 0.5  

Sin(900) = ? > sin(Pi/2); 1  

Arcsin(1) = ? > arcsin(1); ½ Pi Mencari arces 

sinus 1 

Selesaikan : 

tan(cox(x)) = 

1 

> fsolve(tan(cos(x)) = 1 , 

{x}); 

{ x = 

0.6674572160} 

 

10 = ….. 

radian 

> deg := evalf(Pi/180); deg := 

0.0174532925 

10 = 0.174532925 

1 radian = 

…….. derajat 

> rad := 1/deg; rad  = 

57.29577951 

1 rad = 

57.29577951 

Sin(900) =  ? > sin(90*deg); 1 Sin(900) = 1 

Arcsin(1) = ? > arcsin(1) * rad; 28.64788976   

  

> evalf(%); 

 

90.000000002 

Arcsin(1) = 900 

% singkatan dari 

perhitungan 

sebelumnya 

f = Sin(x)2 + 

Sin(x) 

> f := Sin(x)^2 + Sin(x); f := Sin(x)2 + 

Sin(x) 

Mendefinisikan f  

( f(x) ) 

f(Pi/3) = ? > evalf(subs(x=Pi/3, f; 1.616025404 Subsitusi x = Pi/3 

ke f(x) 

 

4. Fungsi 

Bentuk 

Matematika 

Operasi 

Maple 

Hasil Keterangan 

21)( xxf   > f := x -> 

sqrt(1 + x^2);  

f := x  -> sqrt(1 + x2) Mendefinisikan fungsi f 

f( 1 ) = ? > f( 1 ); 2½ Nilai f untuk x = 1 

f( a + 3 ) = ? > f( a + 3 ); (10 + a2 + 6a )½ Nilai f untuk  x = a + 3 

22)( yxxyg    

> g := (x,y) -> 

sqrt(x^2 + 

y^2); 

 

22),(: yxyxg 

 

 

Mendefinisikan fungsi 

dengan 2 variabel 

g(3,4) = ? > g(3,4); 5 g(3,4) = 5 

g(x,y) = ? > g(x,y); 22 yx   22),( yxyxg   
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5. Kalkulus 

Bentuk 

Matematika 

Operasi Maple Hasilnya Keterangan 

Y=Sin(Cos(x)

+x3+1, Y’ = ? 

> diff(sin(cos(x)) + x^3 + 

1, x); 

Cos(cos(x) sin(x) + 3 x2 Mencari 

turunan suatu 

fungsi 

  ?2dxx  > int(x^2, x); 3

3

1
x  

Menghitung 

Integral 

?

1

0

2  dxx  
> int(x^2, x = 0 . . 1); 

3

1
 

Menghitung 

Integral 

tertentu 

?1

1

0

3  dxx

 

> int(sqrt(1+ x^30, x = 0 

..1); 

1.111447971  

 > Int((1-x)/(x-3)^2, x); 
d










1 x

( )x 3 2
x

 

Menulis 

rumus 

integral Int 

huruf “i” 

besar 

 > int((1-x)/(x-3)^2, x); 
 ( )ln x 3

2

x 3
 

Menghitung 

integral int 

huruf “i” 

kecil 

d









1 x

( )x 3 2
x

 

> Int((1-x)/(x-3)^2, x 

)=int((x-1)/(x-3)^2, x); 
d










1 x

( )x 3 2
x  ( )ln x 3

2

x 3

  Rumus dan 

hasil 

perhitungan 

dijadikan 

satu. 

 

2)3(

1






x

x
h  

> h := x -> (1-x)/(x-3)^2; 
 := h x

1 x

( )x 3 2
 Mendefinisik

an fungsi h 

 > Int(Int(h(x),x),x); d

 d

 ( )h x x x  Menuliskan 

Integral lipat 

d

 d

 ( )h x x x

= ? 

> 

Int(Int(h(x),x),x)=int(int(h

(x),x),x); 

  

 

Integral dari 

fungsi h 

k(x,y) = 1 + xy > k := (x,y) -> 1 + x*y; 
k := (x,y)  1 + xy 

Mendefinisik

an fungsi 

dengan 2 

variabel 

bebas 

d



0

2

d



x

x
2

1 x y y x

=? 

>Int(Int(h(x,y),y = x  .. 

x^2), x = 0 .. 2) = 

   Int(int(h(x,y), y = x .. 

x^2), x= 0 .. 2; 

d



0

2

d



x

x
2

1 x y y x  =  

4 

Hasil 

perhitungan 

integran 

ganda 

tertentu 

d









d









1 x

( )x 3 2
x x

  2 ( )ln x 3 ( )ln x 3 ( )x 3 x 3
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lim
x 0

1 x

( )x 3 2

 

 

> limit((1-x)/(x-3)^2, x = 

0); 

9

1
 

Mencari 

harga limit 

fungsi 

 > Limit((1-x)/(x-3)^3, x = 

infinity; 
lim
x 

1 x

( )x 3 2

 

 

lim
x 

1 x

( )x 3 2

 

> limit((1-x)/(x-3)^2, x = 

infinity; 

- ~  

lim
x 1

1 x

( )x 3 2

 

> limit((1-x)/(x-3)^2, x = 1; 0  

2)3(

1
)(






x

x
xh  > h := x -> (1 - x)/(x – 

3)^2; 2)3(

1
:)(






x

x
xxh  

Mendefinisik

an fungsi 

h(x) 

h'(x) = ? > diff(h(x),x); 
32 )3(

)1(2

)3(

1









x

x

x
 

Mencari 

turunan dari 

h(x) 














?

)3(

1
2x

x

dx

d

 

> Diff(h(x), x); 













2)3(

1

x

x

dx

d
 

Menuliskan 

rumus 

differensial 

 > Diff(h(x), x ) = diff(h(x), 

x); 












?

)3(

1
2x

x

dx

d
= 

32 )3(

)1(2

)3(

1









x

x

x
 

Menyatukan 

rumus dan 

hasil 

perhitungan 

differensial 

 > B := Diff(h(x), x) = 

diff(h(x), x); B :=  












?

)3(

1
2x

x

dx

d
 

= 
32 )3(

)1(2

)3(

1









x

x

x
 

Mendefinisik

an fungsi B 

sebagai hasil 

dari turunan 

h(x) 

Cari nilai B 

untuk x = 10 

> subs( x=10, rhs( B ); 

343

11
 

rhs = right 

hand side  

2)3(

1
)(






x

x
xh

 

>Diff(h(x),x$2; 

d

d2

x2













1 x

( )x 3 2

 

Turunan ke 

dua dari h(x) 

 

d

d2

x2













1 x

( )x 3 2

 

>Diff(h(x),x$2=simplify(di

ff(h(x),x$2)); 


d

d2

x2













1 x

( )x 3 2


2 ( )x 3

( )x 3 4
 Hasil turunan 

ke dua dari 

h(x) 
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6. Grafik 

Rumus Matematika Operasi Maple Hasil 

y = x + 2 > plot(x + 2); 

 
y = x2 - 1 > plot(x^2 – 1); 

 

3

)3(
)(

xCos
xCoxy   

> plot(cos(x)-

cos(3*x)/3, x = -Pi..Pi); 

 
Gambar grafik : 

 y = x5 + 13x4 – 69x3 – 

1093x2 +  428x + 

15840 untuk 

  

> plot(x^5+13*x^4-

69*x^3 -  

   1093x^2+428x+1584

0; 

 

Gambar grafik : 














)4(
)3(
)2(

)(

xSiny
xSiny
xSiny

xSiny

  0 < x < Pi 

> 

plot({sin(x),sin(2*x),si

n(3*x),sin(4*x)},x=0..P

1);  
Gambar grafik 3 

dimensi : 

  

  

  

Plot3d(x*y, x=0..3, 

y=0..3); 
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IV.    MINITAB 

 

 

1. Pengertian minitab 

Minitab adalah paket program komputer khusus untuk analisis statistika yang 

bersifat interaktif dengan pemakainya. Karakteristik minitab adalah kemampuannya 

memberikan kesempatan kepada pemakainya untuk menentukan pilihan-pilihan atau 

tahap-tahap proses pengolahan datanya. Minitab adalah perangkat lunak analisis 

statistik yang memungkinkan untuk dengan mudah melakukan analisis data.  

Hasil analisis di program minitab dapat ditampilkan dalam histogram, plot, 

dan angka dengan hanya memberikan satu atau dua perintah, bahkan dapat 

digabungkan dengan program pengolah data lain seperti Office dan Ms.office..  

Minitab dalam melakukan analisis data, seperti yang dijelaskan bahwa 

komputer hanya berperan sebagai alat bantu dalam menganalisis data yang 

ditunjukkan pada sisi sebelah kanan yang dibatasi dengan garis putus-putus. 

Sedangkan di bagian kiri garis pembatas dikerjakan oleh manusia dalam mendesain 

dan menafsirkan output yang dihasilkan Minitab. 

 Minitab digunakan untuk mengolah data seperti:statistika deskriptif ,grafik 

,uji asumsi klasik dan analisis regresi ,rancangan acak lengkap,rancangan blok acak 

lengkap dan tidak lengkap setimbang, analisis data kategorik,uji statistika 

nonparametrik.. 

Window Minitab memiliki menu bar, toolbar, status bar, dan tombol ukuran. 

Menu bar mempunyai menu-menu yang berfungsi menjalankan operasi tertentu, 

contohnya membuka dan menutup suatu window, melakukan perhitungan statistik, 

dan membuat grafik. Toolbar yang terletak dibawah menu bar berfungsi 

memudahkan pengguna menjalankan operasi tertentu. Status bar memberikan 

informasi mengenai window yang sedang aktif, sedangkan tombol ukuran berfungsi 

mengatur ukuran window Minitab. 

Khusus untuk minitab Versi 16, sudah tersedia kumpulan perintah yang 

disebut perintah makro sehingga pemakai tidak perlu bersusah payah mengetik 

perintah-perintah yang cukup panjang jika ingin melaksanakan Pengoperasiannya 

lebih simple daripada SPSS, namun ada beberapa hal yang harus dicatat: 

1. Sebelum data dimasukkan, Setiap kolom harus diformat dahulu. 

2. Kesalahan format akan mengakibatkan data tidak terbaca dengan benar 
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2. Keunggulan Minitab 

Minitab dapat digunakan tidak hanya dalam pengolahan statistik untuk tujuan 

sosial tetapi juga dapat digunakan untuk tujuan teknik. Keunggulan-keunggulan yang 

ada pada Minitab tentu saja hanya dapat dipahami apabila kita sebagai pengguna 

mengerti dan memahami maksud dari keunggulan yang ada tersebut. Beberapa 

kemampuan Minitab adalah : 

1. Tampilan menu lebih lengkap dan disertai toolbar-toolbar yang akan 

memudahkan pengguna dalam menjalankan perintah 

2. Minitab menyediakan StatGuide yang menjelaskan cara melakukan 

interpretasi table dan grafik statistika yang dihasilkan oleh Minitab dengan 

cara yang mudah dipahami. 

3. Ukuran worksheet dinamis dan memuat kolom sampai 4.000 

4. Mempunyai file Minitab Worksheet (MTW) dan Minitab Project (MPJ) 

yang diguankan untuk membedakan file worksheet dan file project. 

5. Menyediakan reportPad agar mudah membuat laporan project yang telah 

dibuat. 

6. Pengguna bisa membuat nama yang panjang pada file tanpa harus 

menyingkat nama file. 

7. Menyediakan fasilitas makro untuk membuat program yang berulangkali 

dipakai, memperluas fungsi Minitab, atau mendesain perintah sendiri. 

Bahasa pemrograman makro lebih mudah. 

 

3. Fasilitas di minitab 

1. Calculations : Fungsi baru kalkulator mencakup manipulasi 

teks,geometrik, dan sebaran binominal 

2. Data and Data: Formula dalam kolom dan konstanta, kemampuan 

3. Window :dan format baru untuk waktu dan tanggal, kolom untuk finansial 

dan persen, fasilitas berkali kali pembatalan perintah (undo/redo). 

4.  File I/O :Password untuk melindungi file proyek, lebih banyak format file 

yang diimpor/ekspor. 

5. Graphs :Grafik baru yang mencakup plot sebaran peluang, dan plot garis, 

kemampuan pengeditan lanjut yang lebih sederhana dan berdaya guna. 

6.  Basic Statistics :Uji baru untuk laju Poisson, dan satu ragam, mode statistic. 

7.  Design of Experiments:Rancangan faktorial penuh lebih optimal (Optimal full 

factorial designs), lebih banyak faktor untuk rancangan respon permukaan, plot 

optimasi, dan pengaruh plot setengah normal (new half normal plot of effects). 

8.  Control Charts: New editing options for control charts. 
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9. Quality Tools:Penghasil lembar kerja Gage R&R, tipe 1 studi gage, 

pendugaan peluang kesalahan klasifikasi, dan lain-lain 

10. Reliability / Survival Analysis: Jaminan Analisis  

11. Multivariate: Alpha Cronbach, analisis faktor, dan biplot untuk komponen 

prinsip (biplot for principal components and factor analyses). 

12. Other Statistics:Kurva power untuk ukuran sampel dan power, grafik 

korelasi silang resolusi tinggi untuk data time seri, dan lain-lain 

13. Documentation :Glossary yang lebih rinci, formula dan dan metode yang 

diperkaya, data-data baru untuk contoh. 

14.  Minitab Automation:Pemrogram anda akan dapat mendayagunakan analisis 

kualitas Minitab dan grafiknya pada komputer dan aplikasi web anda. 

 

4. Cara Membuka Aplikasi Minitab 16 

1. Dari desktop pilih minitab 16 kemudian double klik 

 
2. Maka aplikasi minitab akan terbuka seperti dibawah ini: 

 
 

Atau dengan cara: 

1. Dari star pilih all program 

2. Pilih minitab 16 kemudian klik maka akan terbuka jendela minitab 16 
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5. Layout kerja minitab 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Jendela MINITAB (Minitab windows) terdiri dari tiga bagian yaitu:  

1. Session Windows (Jendela Session) berisi tampilan dari hasil perhi\tungan 

yang dapat disajikan dalam bentuk tabel statistika, kolom, konstanta dan 

matrik 

2. Data Windows (Jendela Data) berisi data yang diinput dengan identifikasi 

berdasarkan posisi di baris dan kolom dalam lembaran kerja (work-\sheet). 

3. Graph Window Jendela Grafik Tempat tampilan grafik yang dihasilkan dari 

perintah minitab 

4.  Toolsbars Tanda Alat Tombol-tombol perintah minitab 

5. Menu bar Tanda Menu Berisi perintah yang dapat diakses melalui keyboard 

atau mouse 

6. Project Manager Manajer Proyek Panduan untuk mengelola lingkungan kerja 

minitab . Bagian yang dikelola yaitu Lembar kerja (Worksheet), grafik (Graph), 

Laporan, dan rekaman perintah-perintah yang telah diberikan oleh pengguna. 

7. Shortcut menu Menu Pintas Ikon-ikon perintah yang tersedia di masing-masing 

jendela program minitab jika pengguna melakukan click kanan dari mouse 

komputer. 

 

6. Menu-menu yang terdapat di minitab 16 

1. Menu file     2. Menu 

Edit 
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3.Menu Data     4. Menu calc 

   
 

5.Menu Stat     6. Menu Graph 

   
 

 7.Menu Editor    8.Menu Tools 
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9.Menu Window   10.Menu Help   

   
 

   11.Menu assistent 

 
 

7. Cara menyimpan File minitab 

1. Klik menu file,pilih save current worksheet dan klik 

2. Pilih foder mana untuk menyimpan 

 
3. Ganti nama file nya lalu save maka file akan tersimpan 
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a. Cara memformat kolom/baris dan memasukkan data: 

1. Variabel yang ingin dimasukkan, pertama-tama diketik secara manual pada 

header yang disediakan. Beri Format untuk masing-masing kolom 

(Text,Numeric,Date/Time) dengan memblok salah satu kolom pada header 

teratas(C1,C2,C3,dst..) dengan cara mengklik kiri salah satu cell yang 

bersangkutan (misal: C1). 

 
2. Kemudian Klik kanan pada cell tersebut dan pilih ‘Format Column’. Untuk 

menu angka dapat dipilih dengan Klik kanan pada cell tersebut>’Format 

Column>Numeric... 

 

Aka

n muncul Menu seperti berikut: 

1. Automatic = Membentuk angka secara otomatis 
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2. Fixed decimal =  Menambahkan dan menentukan banyaknya desimal 

 
 

 

3. Exponential 

 
4. Currency = Memberi Format untuk mata uang 

 
5. Percentage = Memberi Format untuk Persentase 

 
 

Untuk format Teks, dapat di pilih dengan Klik kanan>Format Column>Text 

Untuk format Waktu dan tanggal, dapat dipilih degan Klik kanan>Format 

Column>Date/Time.. 
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8. Contoh soal dan pembahasan 

1. Buatlah data statistik diskriptif dengan menggunakan aplikasi minitab 16 

dengan data seperti dibawah ini : 

 

No Jenis Kelamin 

Nilai 

UAS 

1 Laki-laki 80 

2 Perempuan 75 

3 Perempuan 80 

4 Perempuan 85 

5 Perempuan 79 

6 Laki-laki 85 

7 Laki-laki 82 

8 Perempuan 70 

9 Perempuan 75 

10 Laki-laki 80 

 

2. Seorang peneliti ingin melihat ada pengaruh dan hubungan atau tidaknya 

nilai impor dengan pendapatan nasional Negara dengan menggunakan uji 

regressi dan corellasi. Maka buatlah data tersebut menggunakan minitab 

16 dengan data seperti dibawah ini: 

 

Tahun 

 

nilai impor 

Pendapatan  

Nasional 

 

1995 11,2 330 

1996 11,3 331 

1997 11,7 335 

1998 12,0 346 

1999 14,2 400 

2000 12,0 346 

2001 13,5 390 

2002 15,6 520 

2003 15,6 520 

2004 14,7 450 
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Pembahasan soal: 

1. Menghitung data deskriptif 

 

1. Masukkan data yang akan di cari 

 
2. Klik tab Stat>Basic Statistics>Display Descriptive Statistics 

 
3. Akan muncul pop-up window berjudul ‘Display Descriptive Statistics’. Pilih 

variabel yang akan diproses datanya secara deskriptif, dan variabel 1/lebih 

variabel yang akan menadi acuan. 

 
4. Kemudian klik menu ‘Statistics...’, akan muncul pop-up baru yang berjudul 

‘Display Descriptive Statistics - Statistics’. 

 



Minitab 

49 

 

5.  Pilih beberapa data yang ingin ditampilkan pada window ‘Session’, 

kemudian klik‘Ok’ 

6. Untuk menambah grafik maka di statistk descriptive pilih graph maka akan 

muncul jendela berikut dan ceklis  grafik yang di inginkan: 

 
7. Dan klik ok sekali lagi klik ‘Ok’. 

Akan muncul data seperti dibawah ini. 

 
2.Mencari Regresi sederhana 

1. Masukkan data variabel 

 
2. Klik tab Stat>Regression>Regression 
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3.  Setelah muncul Window ‘Regression’, pilih variabel yang akan dihitung 

regressinya pada kolom ‘Response’ dan variabel prediksinya di kolom 

‘Prediction’ lalu langsung klik ‘Ok’. 

Akan muncul data seperti berikut 

 

 

 

 

 

 

 

 

 

 

 

 

Mencari Korelasi Sederhana 

1. Klik tab ‘Stat>Basic Statistics>Correlation’ 

 

 

 

 

 

 

 

 

 

 

2.   Setelah muncul Window Correlation, masukkan variabel yang akan dicari 

korelasinya dan langsung klik ‘Ok’. 

 
Akan muncul data seperti ini 
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